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U.S. Payroll Tax Tables—March 2014 Update
2014 Government-Mandated Payroll Tax Changes
As a result of legislative changes, the payroll tax tables changed for the following jurisdictions, effective April 1, 2014:

l Wisconsin
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U.S. Payroll Tax Tables—January 2014
Update
2014 Government-Mandated Payroll Tax Changes
As a result of legislative changes, the payroll tax tables changed for the following jurisdictions:

l Illinois

l Massachusetts

l Michigan

l Missouri

l North Dakota

l Oklahoma

l Oregon

l Puerto Rico

l Vermont
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U.S. Payroll Tax Tables—December 2013
Update
Federal Payroll Tax Changes
The federal government has mandated the following payroll tax changes for 2013:

l Maximum taxable earnings for Social Security increase to $117,000 in 2014.

l The annual personal exemption is $3,950 for 2013.

l The PercentageMethod tax tables have changed.

2014 Government-Mandated Payroll Tax Changes
As a result of recent legislative changes, the payroll tax tables have changed for the following jurisdictions:

l California

l Connecticut

l Delaware

l Kansas

l Kentucky

l Maine

l Maryland

l Minnesota

l New Mexico

l New York State and Yonkers

l North Carolina State

l Rhode Island
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Canadian Payroll Tax Tables—December
2013 Update
This section describes the highlights of federal, provincial, andQuebec tax changes.

For more information about these changes, and for information on Employment Insurance, see the Canada Revenue
Agency website.

Federal Payroll Tax Changes
Highlights of the changes to Canadian payroll taxes include the following :

l Income tax thresholds and personal amounts are indexed for 2014.

l CPP maximum pensionable earnings and the basic exemption have changed for 2014. Themaximum contribution
amount has also changed.

Quebec Payroll Tax Changes
Changes to Quebec payroll taxes for 2014 include the following:

l TheQPP contribution rate has changed.

l ThemaximumQPP contribution amount has changed.

Other Provincial and Territorial Payroll Tax Changes
The following provinces and territories havemandated payroll tax changes, effective January 1, 2014:

l Alberta

l British Columbia

l Manitoba

l New Brunswick

l Newfoundland and Labrador

l Northwest Territories

l Nunavut

l Ontario

l Saskatchewan

l Yukon

For detailed information on personal amounts, see the TD1 form for each province or territory.
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Enhancements—Version 19.2
Multi-year general ledger support
As of this release, Sage 100 Contractor no longer requires you to close your books at year end. Instead, as you change your
period from 11 to 12 of your fiscal year, period 1 of the new fiscal year will open so that you can begin entering transactions.
Periods 2 through 12 will become available after advancing to period 1 of the new year with an error free audit report.
Advance the fiscal period using the Change Period feature.

As part of themultiple-year general ledger support, the following changes have beenmade for this release:

n TheClose Yearwizard has been removed; it has been replaced by theArchive Datawizard.

n Sage 100 Contractor does not require you to archive your fiscal year when you advance to the next fiscal year. You can
archive your data at any time. When you perform the archive data process, the Archive Data wizard removes the oldest
fiscal year of data from your current company and stores it in an archive company. If you havemore than one year of data
that requires archiving, perform the archive process more than once.

n Entries you post to period 0 no longer post to an archive. If you post an entry to period 0 after archiving, open the archive,
and then post an entry there.

n Several maintenance features from the Archive Data wizard have also beenmade available as menu options:

p Remove refused/closed jobs in menu 3-5 Jobs (Accounts Receivable)

p Remove paid/void invoices with no job in menu 4-2 Payable Invoices/Credits

p Remove closed purchase orders with no job in menu 6-6-1 PurchaseOrders

p Remove paid/void/completed service records in menu 11-2Work Orders/Invoices/Credits

Close your payroll at the end of the calendar year as with previous releases.

1099/T5018 changes
New changes in General Ledger bring with it new changes with 1099s or T5018s.

n TheReset 1099 or T5018 Balance option is not included in theArchive Datawizard and has been removed from the 4-4
Vendorswindow. Since you now have the ability to archive your fiscal year at your convenience,1099s and T5018s are
calculated at runtime and are available for reporting for multiple years.

n Multiple years of 1099 or T5018 balances can be stored and reported.

n Adjust your vendor 1099 or T5018 balances as required using the new 1099 or T5018 Balance/Startup Adjustment
window.

NOTE: If you use vouchers and did not select theUpdate 1099 or T5018 Balance check box, you will need tomake
adjustments.

n When you install version 19.2, the rebuild indexes will move the 1099 or T5018 balance data to a new field in the Ledger
Transaction table andmove theYTD and Last Year Activity fields to new Vendor Invoice Activity table.
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Sage Advisor Update
Sage Advisor Update notifies you automatically when an update is available for Sage 100 Contractor. You currently receive
an email when an update for Sage 100 Contractor is available. Now a notification in your system tray alerts you when an
update is available for download. Establish your settings now to be prepared for year end. The application appears in the
system tray of yourWindows taskbar. Access it by selectingStart > Programs > Sage > Sage Advisor Update.

IMPORTANT: Youmust have internet access to receive notifications and updates.

File Structure Changes
The Sage 100 Contractor file structure has changed. Some Sage 100 Contractor files have been relocated to comply with
Microsoft Windows operating system requirements.

n Sage 100 Contractor program files and support files have beenmoved to the \Program Files\Sage\Sage 100 Contractor
folder (32 bit systems) or the \Program Files (x86)\Sage\Sage 100 Contractor folder (64 bit systems).

n Company data and shared custom reports remain in theMB7 folder.

n Formore detail about custom report locations, see Knowledgebase article ID 20960.

Reports and Forms
When you install version 19.2, the system reports (RPFs) aremoved to theSystem Reports folder and the form designs
(FDFs) aremoved to theReport Forms folder.

As you create new files, or modify existing files, you will have the option to save those files as either shared or private.
Shared files are accessible to anybody who has access to the company data.

If you save a file as shared, the file is saved inReport Forms orSystem Reports in the \MB7\ folder accordingly.

If you save the file as private, the file is saved in your (%localuserapp%)Custom Reports orReport Forms folder. For
example, you could navigate to your private custom reports and report forms inWindows Explorer, as follows:

Computer > Local Disk C > Users > gwashington >AppData > Local > Sage > Sage 100 Contractor > Custom
Reports orReport Forms

NOTE: Formore detail about custom report locations, see ID: 20960.

U.S. State Certified Reports
Do you have public works projects or self-perform government jobs? FormWH-347 and several state certified reports are
now available through our integration with Aatrix. Properly filled out, this form will satisfy the requirements of Regulations,
Parts 3 and 5 (29 C.F.R., Subtitle A), as to weekly payrolls submitted in connection with contracts subject to the Davis-
Bacon and related Acts.

U.S. state certified reports are available for:

l Alaska

l California

l Colorado
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l Georgia

l Illinois

l Michigan

l New Jersey

l New York

l North Carolina

l Pennsylvania

Inventory Audit
Version 19.2 includes a comprehensive Inventory audit with new repair functionality.

March 2014 Product Update

New forum for Product Enhancement Requests
As of April 1, 2014, theProduct Enhancement Requests link will take you to the Sage 100 Contractor ideas forum, where
you can enter your suggestions.

Default locale for U.S. Payroll Records
In the U.S. edition, a new option in the 5-2-2 Payroll Recordswindow lets you specify whether to use an employee's work
locale or residence locale as the default in timecards, if the timecard line does not specify a job or if the specified job does
not include a locale. When you click Options > Default Option for Locale Column, a separate window opens where you
specify your choice. Your selection is used for the Locale Column in all time-entry windows, including the 5-5-1 Daily
Payroll Entrywindow and the Sage Construction Anywhere plug-in, as well as the 5-2-2 Payroll Recordswindow.
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Fixes—Version 19.2 March 2014 Update
Wehave fixed the following issues in theMarch 2014 product update:

n Wehave significantly improved the performance of the 2-8 Financial Reportwindow when printing a financial report for
multiple companies.

n The 2-2 Balance Sheetwindow now includes profits and losses from prior years in Retained Earnings, rather than in the
Current Profit/Loss, when the ledger includes multiple years.

n You can print the 5-1-6-61 Certified Payroll Detail—Other Deductions report for certified jobs.

n Reports that include subaccounts now print faster in the 2-3 Income Statement and 2-4 General Ledgerwindows.

n After archiving a fiscal year, the 1-7 General ledger Accountswindow and the 2-2-31 Balance Statement-Period and
YTD report now display the correct previous year period balances for the retained earnings account. If you archived a
year using version 19.2 before theMarch 2014 product update and you are concerned about Retained Earnings amounts
that appear on the 2-2-31 Balance Sheet report, see Knowledgebase article 28376.

n When drilling down to a subsidiary ledger from the 2-3-41 Department Income Report Printingwindow, you now drill
down to the same year and period as the report.

n When printing from the 2-8 Financial Reportwindow, the Balance Sheet portion includes profits and losses from prior
years in Retained Earnings, rather than in the Current Profit/Loss, when the ledger includes multiple years.

n When printing the 2-9-21 Statement of Cash Flows for period 1 of a new year, the Increase in Equity section no longer
includes the previous year's net income.

n Checks (cheques, in Canada) entered with a Void status in the 1-1 Checks and Bank Chargeswindow now display the
correct year and period in the 1-3 Journal Transactions and 2-6 Check Registerwindows.

n You can run reports in the 4-1-2 Payable Invoice Listwindow using Between as criteria for vendors that have small or
very large vendor numbers.

n You can now run queries using vendor names in the 4-2 Payable Invoices/Creditswindow.

n In the 4-2 Payable Invoices/Creditswindow, the correct due date for themonth of February is now assigned for vendors
whose due terms are the 15th of themonth.

n Posting using the 5-2-6 Post Payroll to GLwindow is substantially faster with this update.

n In the 5-2-2 Payroll Recordswindow, you can use the plus (+) andminus (-) keys to advance or reverse dates.

n The 5-2-1 Employeeswindow now lets you save a direct deposit Rate Type for an employee.

n The 6-2 Budgets, 6-9 Proposals, and 6-10 Unitary Proposalswindows now display the correct job after you import a
budget or a proposal. (Previously, if you had displayed a different job before importing to another job, the program
imported the budget or the proposal to the correct job, but then displayed the earlier job.)

n When you create a purchase order using the 6-11-1 Request for Proposal window, the purchase order now uses the
cost code and cost type from the Request for Proposal.

n Posting transactions in the 8-6 Equipment Depreciationwindow updates the Last Posted date in the equipment record
using the calendar month and year for the specified posting date.

n The Save Current Grid View option is available in the 9-5 Takeoffswindow.

n You can export change orders by Job/Phase in the 9-5 Takeoffswindow.
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n Appointments you create in the 3-6 Receivable Clientswindow are now correctly saved in the client record and in the
company calendar.

n The archive process can now validate the archive folder when you archive a company that uses the LIFO or FIFO
inventory method.

n In the 1-6 Period and Fiscal Year Managementwindow, the program now finds and repairs any discrepancies in the
ending balance for the Retained Earnings account when you audit your books.

n The progress bar in the ArchiveWizard now advances more evenly, assuring you that the operation is still working.

n You no longer receive a server error message when you send feedback through the Help system.

Fixes for the U.S. Edition
TheMarch 2014 update provides the following fixes for the U.S. Edition:

n The 5-1-6-21 Certified Payroll Report now prints a blank heritage for an employee whose heritage is 0-Decline to
State in the 5-2-1 Employeeswindow.

n You can now specify whether to use an employee's work locale or residence locale as the default in timecards. For more
information about the new option in the 5-2-2 Payroll Recordswindow, see "Default locale for U.S. Payroll Records" in
the Enhancements section of these Release Notes.

Fixes for the Canadian Edition
TheMarch 2014 update provides the following fixes for the Canadian Edition:

n The 5-4-1 Federal Reportingwindow now includes the province when transmitting payroll calculations for employer
CPP contributions and EI premiums to Aatrix. (Before you can print T4s, the provincemust be specified.)

n The 4-3-1 Invoices to Paywindow now displays invoices created for recurring payables.
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Fixes—Version 19.2 January 2014 Update
Wehave fixed the following issues in the January 2014 product update for Sage 100 Contractor version 19.2:

n You can now run queries and non-coded reports using periods not equal to a period you specify as selection criteria.

n 10-3 Schedule now uses the Company Calendar, taking calendar days off into account when calculating schedules.

n 2-2-21 Balance Sheet prints the correct year under the title of the report when you generate a report for a period in a
previous year.

n When you print receivable invoices using the 3-2 Receivable Invoices/Credits report printing window, a default period
appears only if you have saved default selection criteria that includes a period.

n Trial Balance reports (printed using the 2-1 Trial Balance report printing window), include the correct beginning balance
when the first period in the report selection criteria is period 1.

n You can now use the 1-5 Bank Reconciliation window to clear a number of transactions at one time.

n The program now correctly saves budget amounts you enter for subsidiary accounts in theSubaccountswindow
(opened from the 1-7 General Ledger Accountswindow).

n Aging reports now list invoice amounts in the correct column.

n You can now print the 5-1-5-21 Worker's Comp report correctly for a range of jobs or for all jobs using theSeparate
Reports By Job option.

n If you select the Include image files option in the 5-3-8 Close Payroll year window, the program now ignores that
selection if the Images subfolder does not exist. You do not receive an error message, and processing continues.

n When you reverse the entire amount of a previously billed quantity in the 3-9 Unitary Billing window, Sage 100
Contractor correctly updates the Previous Quantity, Previous Amount, Current Quantity, and Current Amount.

n 2-4 General Ledger Reports no longer display a balance forward for temporary (income statement) accounts when the
first period in the report selection criteria is period 1.

Fixes for the U.S. Edition
The January 2014 update provides the following fixes for the U.S. Edition of Sage 100 Contractor:

n This update includes a new function that you can use to remove or to reassign the dates for adjustments to 1099
amounts that were created by the upgrade process.

When you upgrade to version 19.2, Sage 100 Contractor may havemade adjustments to 1099 starting balances to adapt
your existing data for multi-year functionality in the new version. If you use a fiscal year-end that is not December, these
automatic adjustments can be assigned to the wrong fiscal year, or they may duplicate existing adjustments (made if you
reset 1099 starting balances before upgrading, for example). In such cases, you need to use theUpdate or Delete 1099
Adjustments by Datewindow to reassign the dates or to remove all adjustments that were created for a specific date by
the upgrade process.

You open theUpdate or Delete 1099 Adjustments by Datewindow by clicking theUpdate or delete existing
adjustments link on the 1099 Balance Startup/Adjustmentwindow.

For instructions onmaking these adjustments, see the help for theUpdate or Delete 1099 Adjustments by Date
window.
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NOTE: Youmust be logged in as Supervisor to view the Update or Delete 1099 Adjustments by Date link and to
modify these adjustments.

n You can print the 5-1-4-63 State Quarterly Wage Report—Single for one quarter at a time, only. Because you cannot
print the report for multiple quarters between two other specified quarters, we have removed the Between operator.

n You can now print the Alabama Employer's Monthly Return of Income Tax Withheld (5-4-2 A-6) report for December.

n You can now print theWest Virginia Employer's Return of Income Tax Withheld (5-4-2 WV IT-101V ) for December.

Fixes for the Canadian Edition
The January 2014 update provides the following fixes for the Canadian Edition of Sage 100 Contractor:

n This update introduces a new Canadian preparer, Aatrix, that you can use to prepare your employees’ T4 andQuébec
RL-1 sliips.

n You can now eFile your T5018 Slips to the Canada Revenue Agency.

n You can now generate a ROE slip using the new Canadian preparer, Aatrix.

n This update includes a new function that you can use to remove or to reassign the dates for adjustments to T5018
amounts that were created by the upgrade process.

When you upgrade to version 19.2, Sage 100 Contractor may havemade adjustments to T5018 starting balances to
adapt your existing data for multi-year functionality in the new version. If you use a fiscal year-end that is not December,
these automatic adjustments can be assigned to the wrong fiscal year, or they may duplicate existing adjustments
(made if you reset T5018 starting balances before upgrading, for example). In such cases, you need to use theUpdate
or Delete T5018 Adjustments by Datewindow to reassign the dates or to remove all adjustments that were created for
a specific date by the upgrade process.

You open theUpdate or Delete T5018 Adjustments by Datewindow by clicking theUpdate or delete existing
adjustments link on the T5018 Balance Startup/Adjustmentwindow.

NOTE: Youmust be logged in as Supervisor to view the Update or Delete T5018 Adjustments by Date link and to
modify these adjustments.

For instructions onmaking these adjustments, see the help for theUpdate or Delete T5018 Adjustments by Date
window.
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Fixes—Version 19.2 December 2013 Update
Wehave fixed the following issues in the December 2013 product update for Sage 100 Contractor version 19.2:

n If youmodify an invoice you posted previously using the 3-2 Receivable Invoices/Credits, 4-2 Payable
Invoices/Credits, or 11-2 Work Orders/Invoices/Creditswindows, the program now correctly updates the posting
period in the 1-3 Journal Transaction record.

n When you post a credit card receipt to period zero, the program correctly updates sub-account balances for all periods in
the previous year.

n When you print the 5-2-6 Payroll Posting Detail Report after posting in summary, the report now contains all the
details of all the payroll records posted in summary.

n When you advance the period in the 1-6 Change Periodwindow, the program now displays a progress bar while it
creates ledger balance records for the new fiscal year. The Cancel button is not available while the records are being
created, preventing you from inadvertently stopping the process before it is complete.

n When you create a work order by exporting an existing purchase order in the 11-2 Service Work Orderwindow, the new
order now includes all the lines from the original purchase order.

n The Current Quantity field in the 3-9 Unitary Billingwindow now correctly stores all the decimal values you enter in this
field.

n Date fields in the 5-1-6-21 Reporting Variables are now formatted automatically.

n TheGross Profit and Percentage Income and Percentage Income Budget amounts shown on the 2-3-53 Department
Income Statement are correct, even if you do not use the Inventory module.

n When you verify the amount of a contract in the 4-2 Accounts Payable Invoices/Creditswindow, theVerify
Subcontract, Subcontract Summarywindow displays the correct New Contract amount.

n You can now use other operators in addition to "Between" when using Period as one of the selection criteria in Find
Queries.

n When you change the status of an inventory allocation to Shipped in the 12-2 Inventory Allocationwindow, the correct
posting period is used when you save the transaction. You can no longer void a period zero record.

n You can now import comma-delimited files in the 9-6 Add Parts/Update Priceswindow.

n You can now use the 6-3 Job Costwindow to change the billing status of prior year time andmaterials jobs. (DT36593)

n In 5-2-2 Payroll Records timecards, you can now use the plus andminus keys on your keyboard to advance or reverse
dates.

Fixes for the U.S. Edition
The December 2013 update provided the following fixes for the U.S. Edition of Sage 100 Contractor:

n You can now display and print the 5-1-4-63 State Quarterly Wage Report and the 5-1-4-63 Quarterly Earnings Report
properly.

n You can now save designs for 5-1-6-51 Alaska Certified Payroll SystemWeekly, System Bi-Weekly, and System
Federal forms.
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Fixes—Version 19.2 November 2013 Update
Wehave fixed the following issues in the November 2013 product update for Sage 100 Contractor version 19.2:

n When you print a 2-2-31 Income Statement that includes an adjustment for rounding, themessage now reads
"Adjustments due to rounding," as it should.

n The 3-8 Loan Draw Requestwindow now calculates and displays the correct amount in thePrevious column after you
enter an amount in theCurrent column, and then submit a draw request.

n Wehave improved the discount amount message that appears in the 4-2 AP Invoicewindow if you do not enter a
discount for an invoice and the vendor record stipulates a discount rate. If you click Yes in themessage, the program
saves the invoice without applying a discount.

n Wehave restored the ability to preview the 5-1-6-56 Alaska Certified Payroll No Work report.

n The 6-7-1 Subcontract Summary window calculates and displays the correct Invoiced to Date amount.

n In the 11-3 Dispatch Boardwindow, you can now assign a previously unassigned work order that has a start time
beforemidnight and an end time after midnight.

n The 11-1-3-26 Service Invoice Aging Land now includes invoices that were unpaid in the specified reporting period, but
paid before you generate the report.

n In the 12-2 Inventory Allocationwindow, you can now use the button to save job costs automatically when saving a
record.

n Dates that you enter in Find queries are now formatted automatically.

n It is extremely important to move data in your existing Sage 100 Contractor companies into the correct periods in
version 19.2 to support the new multi-year functionality. Therefore, the fiscal year-end dates must be accurate for all the
companies in your previous version before you install version 19.2.

To remind you to check the dates, you now receive a warningmessage when you upgrade to version 19.2 from an earlier
version. Themessage reminds you to verify that the Fiscal Year End Date in each company database is correct before
continuing with the installation, and it explains where to check the dates.

Note to Third-Party Developers
When you add a subcontract with multiple lines using theAdd Subcontract API, the subcontract now includes a Line ID
for all new lines.
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Fixes—Version 19.2 Initial Release
The following issues were fixed in Sage 100 Contractor version 19.2:

n The 6-2Budget Lock Edit check box remains selected after saving your changes using the F7 field property.

n Previous releases required you to change the periodmanually before voiding a transaction from a different fiscal period.
The workflow has been improved so that Sage 100 Contractor automatically changes the period when you attempt to
void the transaction.

n Sage 100 Contractor will not allow you to post invoice payments, cash receipts, retention, or referencing invoice credits
to a period prior to the invoice.

n Sage 100 Contractor excludes secondary payees from accounts payable (AP) invoices when you pay by automated
clearing house (ACH), electronic funds transfer (EFT), or credit card transaction.

n Past discount amounts appear in 4-3-1 Set Invoices to Pay after another invoice is set to pay and 4-3-1 is saved and
closed.

n You can use the word "between" in the Job Name field in 3-5 Jobs or in theVendor Name field in 4-4 Vendors.

n The error message that appears if you attempt to insert a class with an out-of-sequence class number has been
corrected. The previous error message incorrectly displayed the next-to-last class number instead of the last class
number.

n The 9-4 Part/Assembly Classes list displays all classes and subclasses correctly.

n You can assign a technician to a work order without also assigning a date or time.

n TheScheduled Hours column of theDispatch grid in the 11-2Work Orders/Invoices/Credits window calculates
automatically after you enter start and stop times in theScheduled Start andScheduled Finish columns.

n When you create a deposit using the 11-2Work Orders/Invoices/Credits window, the date fills in on the resulting credit
memo automatically.

n TheNoteswindow is accessible when you add notes to any posted transaction. In the previous release, theNotes
window was sometimes inaccessible if a posted transaction had associated job costs.

n You can update all assembly part costs in 9-3 Assemblies > Options. In previous releases, the Total Cost updated
only when you opened each assembly and saved it.

n In 13-3 Report Writer, the program will not quit when selectingGrouping/Sorting.

n The proposal recap feature in 6-9 Proposals and 6-10 Unitary Proposals properly displays all appropriate proposals.

n Inserting a row whenmodifying a report no longer causes the row height to change.

n Modifying grouping and sorting in any of the year-to-date (YTD) earnings reports no longer generates an error message.

n When processing theWorker's Compensation report in payroll, overtime pay for theAdd On calculation is factored into
theWorkers Comp Wages andSubject Wages.

n When you print a range of records in the 6-11-1 Request for Proposal report printing window, the Phase Description on
the System.RFP report form matches the phase number on the Request for Proposal.

n Your saved report selection criteria displays correctly when viewing it through the 7-7 Scheduled Reports Manager
using "in list" in the selection criteria.
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n The Aatrix 5-1-11 report prefills column 2with a 0 value as expected when employees have no standard allowances.

n Adding report notes to a custom report no longer causes errors after you select the report for printing or you load it into the
report writer.

n While operating Sage 100 Contractor onWindows Server 2012, you can print to a rich text format (RTF) file.

n The font border around the dashboard panel has been removed tomake reading the text on individual tiles easier.

n You can drag and drop anMS Outlook email message to a record.

n In the Application Programming Interface (API), the vendor object tagBankAccountPrenoteStatus is the same in both
the XML field library and the XML schema definition (XSD).

n Sage Estimating is now compatible with the .NET API for Sage 100 Contractor.

Fixes for the Canadian Edition
The following issues were fixed specifically for the Canadian edition:

n In the 7-2 Company Information window, theAccount # field has been relabeled as account indicator #.

n Sage 100 Contractor displays all calculated values in the 4-2 Payable Invoices/Creditswindow automatically.

n Sage 100 Contractor audits payroll correctly when you use a single payroll statement as a summary statement (for
example, creating one record for an entire quarter of payroll activity).

n The "1099 only" check box in the 4-1-5-21 report has been changed to read "T5018 only."

n The British Columbia provincial tax amount no longer changes when you perform a trial computation with an override of
the Federal Income Tax.

n The Canadian Sales Tax Setup window has beenmodified to allow you to use the same account for theGST/HST
Collected column for multiple rows. You can also use the same account for theGST/HST Paid column inmore than one
row.

n The Service Tax Report no longer appears on the process map for the Canadian Edition. Menu changes in 19.2

n The Aatrix T5018 form prints the ID number when the vendor type is set toBusiness.

n The billing amount displays on 11-1-2-61, 62, 71, 72, 91 reports.

n The province is available as a selectable report criterion in the 2-11-0-21GST\HST Filing Report window.
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Known Issues and Comments—Version 19.2
The following are known issues and problems in Sage 100 Contractor Version 19.2.

General

Menu changes
l General Ledger 1-6 changed from Change Period/Close Year toPeriod/Fiscal Year Management

l Payroll 5-1-11 changed from DOL WH-347 Certified Report toCertified Payroll Forms (US only)

Process Maps—These two items are included on the system-installed process maps forGeneral Ledger (1-6) and
Payroll (5-1-11).

IMPORTANT: The process maps included with version 19.2 are updated with the new names. If you have
customized these process maps, you will need tomanually update themenu names. InEditmode, right-click the
shortcut and then edit the name, or delete the existing shortcut and then drag and drop the item from the System
Menu.

Check 1099 (U.S.) or T5018 (Canada) balances before installing 19.2
Check your 1099 or T5018 balances prior to installing version 19.2 as Sage 100 Contractor carries your previous (pre-19.2)
version's 1099 or T5018 balances forward into version 19.2.

For example, if you upgrade to 19.2 in late November, and one of your vendors has an existing 1099 or T5018 balance of
$5500 for the calendar year, Sage 100 Contractor carries the $5500 balance forward. When youmake any new vendor
payments, Sage 100 Contractor adds any new 1099 or T5018 amounts to the balance for the remainder of the calendar year
(November and December).

Sage 100 Contractor version 19.2 no longer provides you with the ability to reset 1099 or T5018 balances. To ensure your
balances are accurate before upgrading, rebuild your indexes by selecting 7-4 Rebuild Indexes > Options > Rebuild All
Tables.

After rebuilding your indexes, print the 4-1-1-61 Vendor 1099 or T5018 report. Perform the upgrade to version 19.2, then
compare your pre-upgrade balances with your beginning balances in version 19.2. Make any adjustments as necessary
using the 1099 or T5018 Balance Startup and Adjustmentwindow.

Drive letter pick lists are removed from report printing windows
For version 19.2, drive letter selection fields have been removed from report printing windows to facilitate printing of
scheduled reports. Public, private and shared reports must reside in specific locations. If you had custom reports or logos
stored onmapped drives, please refer to Knowledgebase articles ID 20960, ID 20325, and ID 20260.

Internet Access Required for Sage 100 Contractor
Sage 100 Contractor features, such as printing or efiling tax forms, submitting enhancement requests, accessing Help, or
downloading periodic product or tax updates all require Internet access. To take advantage of these features, please ensure
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any workstation or server that Sage 100 Contractor is installed on has access to the Internet.

During installation of Sage 100 Contractor, the computer serving as the Sage license server must be able to connect to the
Internet to obtain licenses. Once installation is complete, you can check out license uses for each computer where Sage
100 Contractor is installed, then disconnect the Sage license server from the Internet.

NOTE: A static Internet connection using a compatible web browser is required for Sage Construction Anywhere.
See "Appendix A: System Requirements" for supported browsers in the Getting Started Guide at
http://help.sageconstructionanywhere.com/docs/Default.htm.

Tax Forms and eFiling by Aatrix configuration requirements
Tax Forms and eFiling by Aatrix requires an Internet connection for two reasons:

l Updating of the Forms and Executables.

l Electronic Filing (eFiling) of the Forms.

Both of the operations listed can report an Internet connection problem. The vast majority of these problems are a result of
problems communicating through an Internet firewall.

Firewalls need to have access allowed through specific ports:

l The Tax forms and eFiling Updater uses standard SSL/HTTP port 80 to access the site http://updates.aatrix.com.

l The eFiling component uses secure HTTPS on port to access the site https://efile.aatrix.com.

By allowing access to aatrix.com you will allow both updates and eFiling. Occasionally, restrictions are tighter and only
allow access to these ports by specific programs. Tax Forms and eFiling uses the following programs to access the
Internet.

For Updating using http on port 80 to http://updates.aatrix.com:

l aatrixforms.exe

l updater.exe

l updater2.exe

For eFiling using secure http on port 443 to https://efile.aatrix.com:

l builder.exe

l viewer.exe

About network configuration and TCP Remoting Channel
Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component, to enable communication
among computers on a network. By default, Sage 100 Contractor uses the TCP starting port 48750. Certain configurations
can potentially disable the communication:

l File sharing on computers running theWindows 8, Windows 7, Vista, Server 2008, Server 2008 R2, and Server 2012
operating systemmust be enabled. To enable file sharing, follow the instructions in theWindows Help.

l TCP communication requires the selection of port numbers that are not in use by other processes on the local
computer.

http://help.sageconstructionanywhere.com/docs/Default.htm
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l Software firewalls running on the local computer can be configured to block processes from opening TCP ports,
which will prevent communication through the TCP Remoting Channel.

Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-start on
Windows 8, Windows 7 Professional, Vista, Server 2008, or Server 2008 R2
Standard
The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers running the
Windows 8, Windows 7 Professional, Vista Business, Server 2008, or Server 2008 R2 Standard operating systems. If the
service stops, the program displays amessage advising you to take further action to resolve this issue.

Windows operating systems and mapped drives
Mapped drives may not be available when installing on a computer running the following operating systems:

n Windows 8 Professional Edition

n Windows 7 Professional Edition

n Windows Vista

n Windows Server 2008

n Windows Server 2008 R2

n Windows Server 2012 Standard Edition

See theMicrosoft knowledgebase article about allowingmapped drives to display elevated users:
http://support.microsoft.com/kb/937624/

NOTE: If you need to install to amapped drive, install the program to a computer that is running another supported
operating system, such as Windows XP Professional.

Configuring anti-virus software and third-party firewalls
During installation of the Sage 100 Contractor Hosting Framework, theWindows Firewall is configured automatically to
allow the Sage 100 Contractor Hosting Framework to act as a TCP server. If you use some other firewall, however, you
may need tomanually adjust some settings in the firewall in order to ensure proper operation.

You can use the following basic procedure tomanually configure theWindows Firewall to allow the Sage 100 Contractor
Hosting Framework to communicate with other computers. Use it as the basis for manually configuring other third-party
firewall products.

To configure the Windows Firewall:
1 Click Start > Control Panel > Security Center (XP) orSecurity (Vista/Server 2008) orSystem and Security
(Windows 7). ForWindows 8, click Start > All apps > Control Panel > System and Security.

2 OpenWindows Firewall, and select theExceptions tab (XP) orAllow a program or feature through Windows
Firewall (Vista, Windows 7, Windows 8, Server 2008 and Server 2012).

3 If Sage 100 Contractor Hosting Framework is not on the list, then you can add it by selectingAdd Program, then
browsing to the following path:
\MB7\Programs\Sage.CRE.HostingFramework.Service-InstanceConfig.xml.

NOTE: By default, the exception is set to allow access by any computer on the network. If desired, you can refine
this setting by selecting theChange Scope button. Be aware that restricting the scope incorrectly can cause the
computer to be unable to connect with some or all of the other machines on the network.

http://support.microsoft.com/kb/937624/
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Files to exclude when manually configuring your firewall for Windows 8 Professional 32-bit

l C:\MB7

l C:\ProgramData\Sage\Sage 100 Contractor

l C:\Program Files\Sage\Sage 100 Contractor

l C:\ProgramData\Aatrix Software

l C:\Program Files\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows 8 Professional 64-bit

l C:\MB7

l C:\ProgramData\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Aatrix Software

l C:\ProgramData\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows Server 2003

l C:\MB7

l C:\Program Files\Sage\Sage 100 Contractor

l C:\Documents and Settings All Users\Application Data\Sage\Sage 100 Contractor

l C:\Documents and Settings\All Users\application Data\Aatrix Software

l C:\Program Files\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows XP 32-bit

l C:\MB7

l C:\Program Files\Sage\Sage 100 Contractor

l C:\Documents and Settings All Users\Application Data\Sage\Sage 100 Contractor

l C:\Documents and Settings\All Users\application Data\Aatrix Software

l C:\Program Files\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows XP 64-bit
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l C:\MB7

l C:\Documents and Settings\All Users\Application Data\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Aatrix Software

l C:\Documents and Settings\All Users\Application Data\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows Vista 32-bit

l C:\MB7

l C:\ProgramData\Sage\Sage 100 Contractor

l C:\Program Files\Sage\Sage 100 Contractor

l C:\ProgramData\Aatrix Software

l C:\Program Files\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows Vista 64-bit

l C:\MB7

l C:\ProgramData\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Aatrix Software

l C:\ProgramData\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows 7 Professional 32-bit

l C:\MB7

l C:\ProgramData\Sage\Sage 100 Contractor

l C:\Program Files\Sage\Sage 100 Contractor

l C:\ProgramData\Aatrix Software

l C:\Program Files\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows 7 Professional 64-bit
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l C:\MB7

l C:\ProgramData\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Aatrix Software

l C:\ProgramData\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows 8 Professional

l C:\MB7

l C:\ProgramData\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Aatrix Software

l C:\ProgramData\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data

Files to exclude when manually configuring your firewall for Windows Server 2008, 2011, 2012

l C:\MB7

l C:\ProgramData\Sage\Sage 100 Contractor

l C:\ProgramFiles (x86)\Sage\Sage 100 Contractor

l C:\Program Files (x86)\Aatrix Software

l C:\ProgramData\Aatrix Software

l C:\%LocalAppData%\Sage\Sage 100 Contractor

l Network location of Sage 100 Contractor data

PCI DSS Compliance
PCI DSS stands for Payment Card Industry Data Security Standard. It was developed by themajor credit card companies
as a guideline to help organizations that process card payments to prevent credit card fraud, cracking, and various other
security vulnerabilities and threats. A company processing, storing, or transmitting payment card datamust be PCI DSS-
compliant or risk losing its ability to process credit card payments and being audited and/or fined.

Sage 100 Contractor does not currently process credit card payments; however, two Sage 100 Contractor windows provide
data entry fields for credit card numbers and related information:

l 3-6 Receivable Clients, Payment Information tab, underCredit Card Information

l 11-2 Work Orders/Invoices/Credits, Invoice Details tab, Card/Check# field.

In addition, youmay have created user-defined fields to store credit card numbers.
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To avoid any non-compliance with PCI DSS, we recommend against storing credit card information in Sage 100
Contractor. Such storage does not comply with the PCI DSS, and it creates a possible risk for your business.

For more information about PCI DSS standards, click the following link:

https://www.pcisecuritystandards.org/

Locating tax updates
Tax updates are released throughout the year. To get the latest information about tax updates, log on to the Customer
Portal, www.sagecre.com/customerlogon.

Then click Support > Documents > For Customers > Sage 100 Contractor > Release Materials.

Configuring Windows Regional and Short Date Format:
1. Click the [Start] button, point toControl Panel, then click Clock, Language, and Region .

2. Click Region and Language.

3. On the Formats tab, select English (Canada)English (United States).

4. UnderDate and time formats, from the Short date format drop-down list, select dd/MM/yyyyMM/dd/yyyy

5. Click [OK].

6. Close theClock, Language, and Regionwindow.

Windows 8 Professional and Server 2012 Standard Operating
Systems

Windows 8 Professional and Server 2012 Standard "Sleep Mode" prevents
computers from obtaining a license use
If a computer running theWindows 8 Professional or Server 2012 Standard operating system is used as a license server,
when it goes into sleepmode other computers on the network can’t obtain a license.

Set Sleep Mode on your license server computer toNever.

To set the Sleep Mode to “Never”:

1. Start > All apps > Control Panel > System and Security > Power Options.

2. Select Change when computer sleeps.

3. From thePut computer to sleep list, select Never.

Sage licensing (Sage 100 Contractor Hosting Framework) cannot auto-start on
Windows 8
The Sage licensing service (Sage 100 Contractor Hosting Framework) cannot auto-start on computers running the
Windows 8 Professional orWindows 8 Enterprise operating systems. If the service stops, the program displays amessage
advising you to take further action to resolve this issue.

https://www.pcisecuritystandards.org/
http://www.sagecre.com/customerlogon
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Solution for Server 2012 error message about mb7.kpr file
If you encounter an error message about opening themb7.kpr file when launching Sage 100 Contractor on a computer
runningWindows Server 2012, follow these steps to resolve the issue:

1 On theWindow desktop, right-click Start, and then click [Explore].

2 On the left side of the window, under Folders, right-click theMB7 folder, and then select Properties.

3 On theMB7 Propertieswindow, click the [Security] tab.

4 From the list underGroup or User Names, select USERS, then click the [Edit] button.

5 On thePermissionswindow, select USERS again, and underAllow, select the Full control check box.
Selecting Full control, selects all the check boxes necessary for this solution.

6 On thePermissionswindow, click [OK], and then on theMB7 Propertieswindow, click [OK].

Server 2012 network configuration and TCP Remoting Channel
Sage 100 Contractor uses the TCP Remoting Channel, a Microsoft .NET Framework component to enable communication
among computers on a network. File and printer sharing on computers running the Server 2012 operating systemmust be
enabled. To enable file sharing, follow the instructions in theWindows Server 2012 Help.

Windows 7 Professional and Server 2008 R2 Standard Operating
Systems

Launching Sage 100 Contractor to run as administrator for scheduling reports

IMPORTANT: On computers runningWindows 7 Professional or Server 2008 R2 Standard, scheduling Sage 100
Contractor reports requires that you “run as administrator” or to “run the program as administrator.”

Microsoft Windows has changed security rules in theWindows 7 Professional and Server 2008 R2 Standard operating
systems tomake your computer more secure. If you are running Sage 100 Contractor as a typical user, then you have
limited privileges in some areas of the program, such as saving a report schedule. To save a report schedule, youmust
launch Sage 100 Contractor with the command to eitherRun as administrator orRun this program as an
administrator.

When you select either command, the settings are limited to you personally. Your settings to run Sage 100 Contractor as
administrator do not affect the next person who logs on and launches Sage 100 Contractor from this computer. Your
settings on this computer can either be temporary or persistent. For example, when you select Run as administrator, you
run the program as administrator for that session only. When you select Run this program as an administrator, you set
program properties to always run the program as administrator when you log on to this computer.

NOTE: "Run as administrator" and "Run this program as an administrator" are not related toWindows 7
Professional or Server 2008 R2 Standard operating systems user groups but are limited to a specific program you are
running.

To set "Run as administrator":
1 On yourWindows desktop, right-click the Sage 100 Contractor program icon.

2 From the drop-downmenu, to launch the program, click [Run as administrator].

NOTE: SelectingRun as administrator only runs the current session of running Sage 100 Contractor. The setting
does not persist after the session is over.
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To set "Run this program as an administrator":
1 On yourWindows desktop, right-click the Sage 100 Contractor program icon.

2 From the drop-downmenu, click [Properties].

3 On the Sage 100 Contractor Properties window, click the [Compatibility] tab.

4 Under Privileges Level, select Run this program as an administrator.

5 Click [Apply], and then click [OK].

NOTE: SelectingRun this program as an administrator always runs the program with these properties when you
launch the program on this computer. The setting persists.

Windows 7 Professional, Windows 8 Professional, and Server 2008 R2 Standard
"Sleep Mode" prevents computers from obtaining a license use
If a computer running theWindows 7 Professional, Windows 8, or Server 2008 R2 Standard operating system is used as a
license server, when it goes into sleepmode other computers on the network can’t obtain a license.

Set Sleep Mode on your license server computer toNever.

To set the Sleep Mode to “Never”:

1. Start > Control Panel > System and Security > Power Options.

2. Select Change when computer sleeps.

3. From thePut computer to sleep list, select Never.

Solution for Server 2008 R2 "Permission Error Opening File"
If you see a permission error message when launching Sage 100 Contractor on a computer running theWindows Server
2008 R2 operating system, follow these instructions:

1 On theWindow desktop, right-click Start, and then click Open Windows Explorer.

2 On the left side of the window, underComputer > Local Disk, right-click the \MB7 folder, and then select Properties.

3 On theMB7 Propertieswindow, click theSecurity tab.

4 From the list underGroup or User Names, select USERS, and then click theEdit button.

5 On thePermissionswindow, select USERS again, and underAllow, select the Full control check box.

6 Selecting Full control selects all the check boxes necessary for this solution.

7 On thePermissionswindow, click OK, and then on theMB7 Propertieswindow, click [OK].

Windows Server 2008 R2 and Microsoft .NET 3.5.1
Microsoft .NET 3.5.1 must be available and enabled prior to installing Sage 100 Contractor on aWindows Server 2008 R2
machine. Server 2008 R2 comes with .NET 3.5.1 loaded but not installed, so Sage 100 Contractor doesn’t install it
automatically.

If you attempt to install Sage 100 Contractor without .NET 3.5.1 installed, you will receive the followingmessage during the
licensing install: “Sage.CRE.HostingFramework.Service v3.2 has stopped working.”When you click [OK], the installation
continues, but the services have not been installed so Sage 100 Contractor cannot open. The
Sage.CRE.HostingFramework Service will not install unless .NET 3.5.1 has been installed. If you receive the above
message during installation, install .NET Framework 3.5.1 and reinstall Sage 100 Contractor.
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To verify that .NET 3.5.1 is installed on Windows Server 2008 R2:
1 Click theStart button in the lower left corner of the display.

2 Highlight Administrative Tools and select Server Manager.

3 In theServer Manager interface, click Features to display all the installed Features in the right-hand pane. Verify that
.NET Framework 3.5.1 is listed.

To enable .NET 3.5.1 on Windows Server 2008 R2:
1 In theServer Manager interface, select Add Features to display a list of possible features.

2 In theSelect Features interface, expand .NET Framework 3.5.1 Features.

3 Once you expand .NET Framework 3.5.1 Features, you will see two check boxes. Check the box next to .NET
Framework 3.5.1 and click Next.

4 In theConfirm Installation Selections interface, review the selections and then click [Install].

5 Allow the installation process to complete and then click [Close].

NOTE: Enabling .NET Framework 3.5.1may require a reboot.
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Solution for Windows 2008 Server R2 Application Error Message
Under some circumstances, on servers operatingWindows 2008 Server R2, youmay experience the following error
message when trying to open a photograph or image file in Sage 100 Contractor:

"No application is associated with the specific file associated with this application."

This error message appears when you attempt to open an image file in Sage 100 Contractor but you have not yet enabled
the Desktop Experience feature inWindows 2008 Server R2. If you receive this error message, install Desktop Experience
using the Server Manager utility:

1 InWindows 2008 Server R2, select Start > All Programs > Administrative Tools > Server Manager.

2 In theServer Managerwindow, click Features (left-hand pane).

3 In the Features pane, click Add Features.

4 Select the Desktop Experience check box.

5 If you are prompted to add additional features, click [Add Required Features].

6 Click [Next].

7 Click [Install].

Windows Vista and Server 2008 Operating Systems

Solution for Server 2008 "Permission Error Opening File"
If you see a permission error message when launching Sage 100 Contractor on a computer running theWindows Server
2008 operating system, follow these instructions:

1 On theWindow desktop, right-click Start, and then click [Explore].

2 On the left side of the window, under Folders, right-click the \MB7 folder, and then select Properties.

3 On theMB7 Propertieswindow, click theSecurity tab.

4 From the list underGroup or User Names, select USERS, then click the [Edit] button.

5 On thePermissionswindow, select USERS again, and underAllow, select the Full control check box. Selecting Full
control selects all the check boxes necessary for this solution.

6 On thePermissionswindow, click [OK], and then on theMB7 Propertieswindow, click [OK].

Vista and Server 2008 “Sleep Mode” prevents computers from obtaining a license
use
If you are using a Vista or Server 2008 computer as the Sage license server and it goes intoSleep Mode, the workstations
cannot obtain a license use.

Use a different computer on your network to be the Sage license server. Any supported operating system can be used in
place of Vista or Server 2008, for example, Windows XP.

Set Sleep Mode on your license server computer toNever.

To set the Sleep Mode to "Never":
1 Start > Control Panel > System and Maintenance > Power Options.

2 Select Change when computer sleeps.
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3 From thePut computer to sleep list, select Never.

Vista, Windows 7, and Server 2008 and changing the Sage License Server
computer
On a Vista, Windows 7, or Server 2008 workstation, when you select File > Change Sage License Server > Select the
computer from the list of computers on your network, the commandmay fail to generate a list of network computer
names. To resolve this issue, click Enter the IP address or name of the computer, and then type the IP address of the
server computer in the box.

Possible conflict when running scheduled reports on Vista Business 64-bit
operating system
On computers running the Vista Business operating system, the Sage 100 Contractor report scheduler may encounter a
conflict with theMicrosoft print spooler (splwow.exe) andmay not function as expected.

A solution for avoiding this possible conflict would be to schedule reports on computers running a 32-bit operating system or
on computers running the XP 64-bit operating system.

Faxing and Adobe Reader

Use Adobe Reader Version 8.1.3 or later for faxing
Customers have reported problems faxing from Sage 100 Contractor with versions of Adobe Reader earlier than 8.1.3. Note
that Adobe Reader Version 8.1.3 and later support faxing fromWindows and from Sage 100 Contractor.

IMPORTANT: To fax from Sage 100 Contractor, theWindows Fax Service component must be installed with your
Windows operating system. For more information about installing theWindows Fax Service component, see the Sage
100 Contractor Help topic, “Installing theWindows Fax Service component.”
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Note for Third-Party Developers
Updates to the API
The Canada API Object ReferenceGuide lists GSTRateOverride, PSTRateOverride, HSTRateOverride, and
PSTIsCompounded as "New" (in the R/W column), suggesting that they should be available forWorkOrderAdd and
WorkOrderMod. However, in the initial Version 19.2 release, the schema did not allow these elements.

To ensure that these fields are all accepted through the API without error, we havemade the followingmodifications to the
API:

l WeaddedGSTRateOverride, PSTRateOverride, andHSTRateOverride to the schema for both the
WorkOrderAdd andWorkOrderMod.

l We removed IsPSTCompounded from the Canada API schema.
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